

    
      
          
            
  
Xena1564 User Manual


Table of Contents


	Overview

	Installation

	Getting Started
	EPL, Port-Based

	E-LAN, Port-Based

	EPL With C-Tag

	EPL with IP





	General Panels
	Main Application View





	Test Configuration Panels
	Ethernet Service Creation Dialog

	Physical Ports Panel

	Service UNI Configuration Panel

	Bandwidth Profile Panel

	Configuration Test Panel

	Performance Test Panel

	Reporting Options Panel





	Troubleshooting
	Basic Instructions

	Additional Details





	Glossary of Terms





Search Page


Footnotes



            

          

      

      

    

  

    
      
          
            
  
Overview


[image: _images/overview.png]

Fig. 1 Xena1564 overview



This is the user manual for Xena1564. Xena1564 is a PC application that lets you perform advanced network tests according to the ITU-T Y.1564[#1] standard using one or more of the Xena test equipment chassis.

The Xena1564 application features the following capabilities:


	Enables the user to create, edit and execute test configurations using Xena Networks test equipment in accordance with the ITU-T Y.1564[#2] standard.


	Define test configuration using standard MEF 10.2[#3] / ITU-T Y.1564[#4] terminology.


	Full support for both ITU-T Y.1564[#5] configuration and performance test types.


	Ability to define multiple Ethernet services.


	Ability to execute test on one, several or all defined Ethernet services.


	Ability to organize defined services in a custom folder hierarchy.


	Support for multiple ValkyrieBay and ValkyrieCompact test chassis.


	Support for different network topologies and traffic flow directions.


	Support for both layer 2 and layer 3 testing.


	Support for either IPv4 or IPv6.


	Ability to flexibly define the protocol layers supported by each user-to-network interface (UNI) - Ethernet, Customer and Service VLANs, MPLS, IP and UDP.


	Ability to define either per-UNI or per-CoS bandwidth profiles for each UNI.


	Ability to specify CoS-to-DSCP mapping.


	Test reports can be created in either PDF or XML format or both.


	Extensive configuration options to fine-tune the tests.





Footnotes



[#1]
https://www.itu.int/rec/T-REC-Y.1564-201602-I/en



[#2]
https://www.itu.int/rec/T-REC-Y.1564-201602-I/en



[#3]
https://wiki.mef.net/download/attachments/32248297/MEF%2010.2.pdf



[#4]
https://www.itu.int/rec/T-REC-Y.1564-201602-I/en



[#5]
https://www.itu.int/rec/T-REC-Y.1564-201602-I/en





            

          

      

      

    

  

    
      
          
            
  
Installation

Xena1564 is a Windows desktop application compatible with Windows 8 and later versions.

It comes pre-installed as an integral component of the standard Xena software release package, which is available for download from this source[#1].

Following the installation, you can locate a shortcut to the application in the Start ‣ Programs ‣ Xena Network menu, and additionally (if you opted for this during the setup process), on your desktop.


[image: ../_images/installation.png]


Footnotes



[#1]
https://xenanetworks.com/l23-downloadsw/





            

          

      

      

    

  

    
      
          
            
  
Getting Started

This section explains how to create a few common test configurations.



	EPL, Port-Based
	Add Chassis

	Create Service

	Create Bandwidth Profile

	Add UNIs

	Start Configuration Test

	Start Performance Test





	E-LAN, Port-Based

	EPL With C-Tag

	EPL with IP






Footnotes



            

          

      

      

    

  

    
      
          
            
  
EPL, Port-Based

In this scenario we will create a simple EPL service with no VLAN multiplexing on the UNI (i.e. port-based) using plain Ethernet traffic.


Add Chassis


	Click the Add Chassis button in the main toolbar. This will display the dialog shown below.





[image: ../_images/add_chassis.png]

Fig. 2 Add Chassis button




	Enter the IP address and password of a Xena chassis and press OK.





[image: ../_images/add_chassis_2.png]

Fig. 3 Add Chassis dialog window




[image: ../_images/add_chassis_3.png]

Fig. 4 Chassis added





Create Service

Create a new Ethernet service either by clicking the Create Service icon in the small toolbar at the top of the Defined Services tree panel, located at the left part of the application, or by right-clicking on the All Services root in the Defined Services tree panel and selecting the Create Service menu option. This will display the dialog shown in the image.


[image: ../_images/create_service.png]

Fig. 5 Create Service




	Enter a suitable label for the service to make it easy to identify it later on.


	Set the Service Type to EPL (should be the default choice). Leave the Is Virtual Service checkbox unchecked as we want to define a port-based service.





[image: ../_images/create_service_epl.png]

Fig. 6 Create Service dialog - EPL




	Optionally modify the Service Acceptance Criteria to use in the test. These values represents the guarantees you want to issue to the user of the service as part of the Service Level Agreement (SLA) for this service. If one or more of the criteria should not be used in the test you can deselect them using the Use in test checkboxes to the right.


	Finally you need to specify the Testflow Characteristics. For an EPL you can only select the Pairs topology as the other topology options are only relevant for multipoint configurations. You can however select the direction for the test traffic. You should keep the default choice of Bidirectional for this test.


	Press the EPL``Create button to create your service.






Create Bandwidth Profile


	Switch to the Bandwidth Profiles panel and click the Create Profile button in the small toolbar at the top of the panel. A new entry will now be inserted in the list below. If you cannot see the Bandwidth Profiles panel tab in the tabbed view you can either enlarge the main window until the tab pops into view or you can select the Bandwidth Profiles menu item in the View menu. Alternatively you can click on the little down-arrow in the right edge of the tab-bar and select the Bandwidth Profiles panel.





[image: ../_images/create_bw_profile.png]

Fig. 7 Create Bandwidth Profile




	Click the cell in the CIR column and enter the committed bandwidth you want the UNIs to provide.





[image: ../_images/create_bw_profile_2.png]

Fig. 8 Edit Bandwidth Profile




	Optionally click the cell in the EIR column and enter the additional excess bandwidth you want the UNIs to provide.


	You can also optionally modify the CBS and EBS values. The default value for both is 12176, according to MEF 13, clause 36.






Add UNIs


	Switch to the Physical Ports panel. Expand the module(s) as needed and locate two ports that you want to use in your test.


	Select the ports, either one by one or both at the same time, drag them to the service you created in the Defined Services tree view and drop them onto the service.





[image: ../_images/add_uni.png]

Fig. 9 Drag and drop ports to service




	The two UNIs will now be shown under the service in the services tree view. Notice that the cells under the Group column contains the text Select Group…. Change this value to EAST for the first UNI and WEST for the other.


	Switch to the Service/UNI Configuration panel. Select the first UNI to view the UNI configuration panel as shown below.





[image: ../_images/service_uni_panel.png]

Fig. 10 Service UNI panel




	For this test we will just leave the default traffic settings (plain Ethernet, no VLANs, no IP, etc).


	Select the Ingress Bandwidth Profiles sub-tab and set the Per-UNI Bandwidth Profile to point to the profile we just created.





[image: ../_images/ingress_bw_profile.png]

Fig. 11 Ingress Bandwidth Profile panel




	Do the same for the other UNI.


	Save your configuration and give it a suitable filename.






Start Configuration Test


[image: ../_images/conf_test_panel.png]

Fig. 12 Configuration Test Panel




	Click the Start Configuration Test button in the main toolbar.


	The Result Data Grid panel will now be shown automatically. Here you can follow the progress of the test.


	Once the test completes the resulting PDF report should open automatically in the default PDF viewer application on your PC.






Start Performance Test


[image: ../_images/perf_test_panel.png]

Fig. 13 Performance Test Panel




	Click the Start Performance Test button in the main toolbar.


	The Result Data Grid panel will now be shown automatically. Here you can follow the progress of the test.


	Once the test completes the resulting PDF report should open automatically in the default PDF viewer application on your PC.






Footnotes



            

          

      

      

    

  

    
      
          
            
  
E-LAN, Port-Based

This example expands a bit on the first example and will thus only describe the new features in details. You can either use the same configuration as for the first example or you can create a new configuration.


	Add a Xena chassis to the configuration (or re-use the one you already have).


	Create a new Ethernet service. Set the Service Type to E-LAN. Set the testflow topology to Mesh.





[image: ../_images/create_service_elan.png]

Fig. 14 Create Service dialog - E-LAN (Mesh)




	Select 3 suitable ports in the Physical Ports panel and drag and drop them to the service you just created.


	Set the Per-UNI bandwidth profile for each UNI to a suitable bandwidth profile (reuse the one you created before or create a new one for this test.


	Save your configuration.


	Right-click on the service you just created in the Defined Services tree view and select the Run Configuration Test (for this service only) item.





Footnotes



            

          

      

      

    

  

    
      
          
            
  
EPL With C-Tag

This example also expands on the first example and shows how to add service multiplexing using a Customer VLAN tag (C-TAG) and also how to enable per-CoS bandwidth profiles. We will create an EVPL service with a C-TAG value of 10, using bandwidth profiles for CoS value 1 and 5.


	Add a Xena chassis to the configuration (or re-use the one you already have).


	Create a new Ethernet service. Set the Service Type to EPL and check the Is Virtual checkbox.





[image: ../_images/create_service_epl_virtual.png]

Fig. 15 Create Service dialog - EPL (is virtual)




	Go to the Bandwidth Profiles panel and create and configure two new profiles, one for each CoS value we want to use. The CIR/EIR values should preferably be different so that you can see a difference when you run the test.


	Add two suitable ports to the service. Assign each of the ports to a different direction group (EAST or WEST).


	Select both UNIs in the tree view and change to the Service/UNI Configuration panel. Check the VLAN: Customer Tag checkbox and set the C-tag value in the Frame Editor to 10.





[image: ../_images/add_uni_ctag.png]

Fig. 16 Add C-Tag 10 to UNI




	Change to the Ingress Bandwidth Profiles tab. Select the Use Per-CoS Bandwidth Profiles option.





[image: ../_images/create_bw_profile_cos.png]

Fig. 17 Use Per-CoS Bandwidth Profile




	Press the Add button. Set the CoS value to 1 and select the first profile you created above. Ignore the DSCP settings and press OK.


	Add another CoS-profile mapping for CoS value 5.


	Save your configuration.


	Right-click on the service you just created in the Defined Services tree view and select the Run Configuration Test (for this service only) item.





Footnotes



            

          

      

      

    

  

    
      
          
            
  
EPL with IP

This example shows how to setup IP traffic on a service.


	Add a Xena chassis to the configuration (or re-use the one you already have).


	Create a new Ethernet service. Set the Service Type to EPL.


	Change to the Physical Ports panel. Select two suitable ports to use and assign an IP address to each in the configuration panel at the bottom of the main port panel. Optionally assign a gateway address as well if your network setup requires this.


	Add the two ports to the service as UNIs. Assign each of the UNIs to a different direction group (EAST or WEST).


	Select both UNIs and enable IPv4 Header in the Frame Configuration. Also assign a bandwidth profile to each UNI.





[image: ../_images/add_uni_ip.png]

Fig. 18 Enable IP in UNI




	Save your configuration.


	Right-click on the service you just created in the Defined Services tree view and select the Run Configuration Test (for this service only) item.





Footnotes



            

          

      

      

    

  

    
      
          
            
  
General Panels

The application uses a tabbed panel layout to divide the functionality into separate areas. The following sections briefly explain the main areas of the GUI.


Main Application View

The main Xena1564 application view is shown in the image below.


[image: ../_images/general.png]

The numbered parts of the view are:


	The menu bar.


	The toolbar providing easy access to the most needed functions in the menu bar.


	The main tabbed panel containing the function panels.


	The service tree view showing all defined services and their UNIs.


	Content of the main tabbed panel.


	The results grid and plot panels - here shown in hidden state.


	The status bar showing current status and progress information.
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Test Configuration Panels



	Ethernet Service Creation Dialog
	Service Type
	Ethernet Private Line (EPL)

	Ethernet Virtual Private Line (EVPL)

	Ethernet Local Area Networks (E-LAN)

	Ethernet Tree (E-Tree)





	Service Acceptance Criteria

	Testflow Characteristics





	Physical Ports Panel
	Port Settings

	IP Address

	Public IP Address

	Remote Loop IP Address





	Service UNI Configuration Panel
	Frame Configuration

	Ingress Bandwidth Profiles

	Egress Bandwidth Profiles





	Bandwidth Profile Panel
	CIR - Committed Information Rate

	EIR - Excess Information Rate

	CBS - Committed Burst Size

	EBS - Excess Burst Size

	Color Markings





	Configuration Test Panel
	Select Test Steps

	Test Execution Parameters
	Common Parameters

	CIR Step-Load Parameters

	Traffic Policing Parameters

	L3 Address Refresh

	Misc. Settings





	Frame Sizes





	Performance Test Panel
	Time Period

	Availability Settings

	L3 Address Refresh

	Misc. Settings

	Frame Sizes





	Reporting Options Panel
	Identification

	Report Generation

	Report Formats

	XML Report Specification
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Ethernet Service Creation Dialog


[image: ../../_images/service_creation_dialog.png]

Fig. 19 Ethernet Service creation dialog




Service Type


Ethernet Private Line (EPL)

Ethernet Private Line is a Point-to-Point service. It consists of two User Network Interfaces (UNIs) with one EVC provisioned between them.


[image: ../../_images/epl.png]

Fig. 20 Ethernet Private Line (EPL)





Ethernet Virtual Private Line (EVPL)

Ethernet Virtual Private Line (EVPL) is a Point-to-Multipoint service. It consists of two or more user network interfaces (UNIs) with multiple EVCs between them (service multiplexing).


[image: ../../_images/evpl.png]

Fig. 21 Ethernet Virtual Private Line (EVPL)





Ethernet Local Area Networks (E-LAN)

Ethernet Local Area Networks (E-LAN) - provides a multipoint topology like a local network. Each node can reach any other node.


[image: ../../_images/elan.png]

Fig. 22 Ethernet Local Area Networks (E-LAN)





Ethernet Tree (E-Tree)

Ethernet Tree (E-Tree) - a rooted multi-point service that connects a number of UNIs providing sites with hub and spoke multipoint connectivity. Each UNI is designated as either root or leaf .


[image: ../../_images/etree.png]

Fig. 23 Ethernet Tree (E-Tree)






Service Acceptance Criteria

These values represents the guarantees you want to issue to the user of the service as part of the Service Level Agreement (SLA) for this service. If one or more of the criteria should not be used in the test you can deselect them using the Use in test checkboxes to the right.



Testflow Characteristics

Specify the Testflow Characteristics. For an EPL you can only select the “Pairs” topology as the other topology options are only relevant for multipoint configurations.

You can, however, select the direction for the test traffic.  You should keep the default choice of “Bidirectional” for this test.
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Physical Ports Panel


[image: ../../_images/add_ports_to_service.png]

Fig. 24 Add ports to service



Drag and Drop the ports you want to use on to the right service.


Port Settings


[image: ../../_images/port_settings.png]

Fig. 25 Port Settings




	Inter-Frame Gap

Specifies the minimum gap between frames generated for a port, expressed as a number of bytes.



	Speed Reduction

Specifies an optional speed reduction on the transmit side of the port, expressed as a ppm value.



	Enable PAUSE Mode

Controls whether the port responds to incoming PAUSE frames.



	Enable Auto-Negotiation

Controls whether auto-negotiation for the port is enabled or not.



	Latency Offset

An optional offset in nanoseconds for the port which is used for latency measurements. You can measure an appropriate value for this by looping two test ports together and performing a latency test. The resulting average latency of this test should be zero.
If this is not the case you can adjust the Latency Offset value until you reach a zero value. Then you can use the calibrated value in other tests.







IP Address


[image: ../../_images/ip_address.png]

Fig. 26 IP Address



Set the IP Address IPv4/IPv4 if this is a Layer 3 test.



Public IP Address


[image: ../../_images/public_ip_address.png]

Fig. 27 Public IP Address




	Public IP Address

If a port is located behind a NAT firewall/router it may be necessary to provide the public IP address offered by the NAT firewall/router.

Xena1564 will then perform an ARP request for the public IP address before starting the test to avoid packet loss due to an initial ARP phase.The real (internal) IP address of the port must still be configured in the main port grid as this may be used to send Gratuitous ARP packets from the port to the router before starting the test.



	Public IP Prefix

The network prefix value for the public IP address.







Remote Loop IP Address


[image: ../../_images/remote_loop_endpoint.png]

Fig. 28 Remote Loop IP Address



When a port with layer-3 protocol segments (IPv4/IPv6) has been configured as a looped port you must specify the IP address of the remote port so that the Xena tester can perform an ARP request for the MAC address.
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Service UNI Configuration Panel


Frame Configuration


[image: ../../_images/frame_config.png]

Fig. 29 Frame Configuration




	Frame Header Composition

Select the needed headers for the test. Fill in the values for the selected headers.



	Frame Payload

Defines the payload type and value.



	Pattern mean you can set your own custom pattern.


	Incrementing means 000102030405...FF00010203... provides built-in data integrity check for payload.


	PRBS provides Pseudo Random Bit Sequence of 2^31-1 pattern. No data integrity with adding Payload checksum in port properties













Ingress Bandwidth Profiles

Limits the rates of frames entering the CEN. Bandwidth Profile can be applied: Per UNI or Per CoS.


[image: ../../_images/ingress_bw_profile_per_uni.png]

Fig. 30 Ingress Bandwidth Profiles (Per UNI)




[image: ../../_images/ingress_bw_profile_per_cos.png]

Fig. 31 Ingress Bandwidth Profiles (Per CoS)





Egress Bandwidth Profiles

Limits the rates of frames entering the CEN. Bandwidth Profile can be applied: Per UNI.


[image: ../../_images/egress_bw_profile_per_uni.png]

Fig. 32 Egress Bandwidth Profiles (Per UNI)
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Bandwidth Profile Panel


[image: ../../_images/bw_profile_panel.png]

Fig. 33 Bandwidth Profile panel



A Bandwidth Profile (BWP) enforces limits on bandwidth utilization according to the Service Level Specification (SLS) that has been agreed upon by the Subscriber and the Service Provider as part of the Service Level Agreement (SLA). It can be thought of as enforcing the long term average guaranteed bandwidth (CIR) and excess bandwidth (EIR) allowed by the service.

Select the Bandwidth Profiles tab and click the Create Profile button in the small toolbar at the top of the panel.

Click the cell in the CIR column and enter the committed bandwidth you want the UNIs to provide.

Optionally, click the cell in the EIR column and enter the additional excess bandwidth you want the UNIs to provide.

You can also optionally modify the CBS and EBS values. The default value for both is 12176, according to MEF 13, clause 36[#1].


CIR - Committed Information Rate

CIR (Committed Information Rate) is the bit rate for which the SP provides performance guarantees in terms of performance attributes for the service.



EIR - Excess Information Rate

EIR (Excess Information Rate) is the additional bit-rate that the subscriber can utilize and for which traffic can probably pass through the CEN as long as there is no congestion.


Note

Note that the total rate, sometimes known as PIR (Peak Information Rate), is the sum of CIR and EIR.





CBS - Committed Burst Size

The short-term burst, in bytes, allowed on the UNI for traffic to be conformant.



EBS - Excess Burst Size

The additional short-term burst, in bytes, allowed on the UNI.



Color Markings


[image: ../../_images/color_marking.png]

Fig. 34 Color Markings




	Green

Frames within the CIR / CBS compliance level. These frames are subject to the SLS.



	Yellow

Frames exceeding the CIR/CBS but are within the EIR/EBS. These frames are delivered as “best effort” without being subject to the SLS. The CEN may drop some or all of these frames based on congestion conditions in the network.



	Red

Frames that do not conform to either the CIR/CBS or the EIR/EBS are dropped.







Footnotes



[#1]
https://wiki.mef.net/display/CESG/MEF+10.3+-+Ethernet+Services+Attributes





            

          

      

      

    

  

    
      
          
            
  
Configuration Test Panel


[image: ../../_images/config_test.png]

Fig. 35 Configuration Test Panel




Select Test Steps


	Simple CIR validation test Y.1564, chapter 8.1.2, test A.1.

During the test, the transmitting probe generates frames at the CIR rate.

The receiving probe measures the received rate, loss, delay, and jitter on the stream. The test fails if any of the maximum frame loss ratio, delay, or jitter thresholds are violated.



	EIR configuration test - Y.1564, chapter 8.1.2, test B.

During the test, the transmitting probe generates frames at the CIR + EIR rate.

The receiving probe measures received rate, loss, delay, and jitter on the stream. The test fails if the measured rate is less than CIR*( 1-max_loss ).







Test Execution Parameters


Common Parameters


	Duration

Fill in the duration of each iteration.



	Iterations

Fill in the number of iteration per this test.



	Break Test On Fail

Stop test immediately as it would imply a configuration error.







CIR Step-Load Parameters


	Start Rate

The Rate in which the test will start.



	Step Rate

The Rate increment value.







Traffic Policing Parameters


	Grace Factor

This is the value referred to in the standard as M Factor. The M factor is added to allow for the effect of the traffic policer’s CBS and EBS settings, and test time.







L3 Address Refresh

If the Enable Refresh checkbox is checked the tester will periodically emit ARP requests (for IPv4) or Neighbor Advertisement requests (for IPv6).

The period can be set using the Refresh Period field.



Misc. Settings


	Latency Mode

Select the Latency mode to be measured.








Frame Sizes


	ITU-T Default

The default setting is to use the ITU-T standard frame sizes: 64, 128, 256, 512, 1024, 1280 and 1518 bytes.



	Custom Sizes

Lets you specify a comma-separated list of values - useful if you only want to test using one or two packet sizes



	Size Range

Lets you specify a a range of packet sizes and the steps.



	Incrementing Sizes

Lets you specify a Min and Max size - the sizes: Min,Min+1,Min+2,…,Max.



	Butterfly Sizes:

Lets you specify a Min and Max size - the sizes: Min, Max, Min+1, Max-1, Min+2, Max-2,…



	Random Sizes:

Lets you specify a Min and Max size - the sizes will vary between Min and Max randomly.







Footnotes



            

          

      

      

    

  

    
      
          
            
  
Performance Test Panel


[image: ../../_images/perf_test.png]

Fig. 36 Performance Test Panel




Time Period

Select how long you would like to run the test.

Unbounded mean it will stopped manually by the user.



Availability Settings

The Ethernet service availability definition is based on a model which uses two states corresponding to the ability or inability of the network to sustain the service in the available state. Transitions between the states of the model are governed by the occurrence of patterns of Severe Errored Second (SES) in the Ethernet layer (SESETH). This Recommendation views availability from the network perspective, where availability performance is characterized independently of user behavior.

A period of unavailable time begins at the onset of 10 consecutive SESETH outcomes. The corresponding period of time is considered to be part of unavailable time. During the unavailable time period, the Ethernet network is in unavailable state. A new period of available time begins at the onset of 10 consecutive non-SESETH outcomes. The corresponding period of time is considered to be part of available time. During the available time period, the Ethernet network is in available state. The figure below illustrates the definition of criteria for transition to/from the unavailable state.

This definition of availability has been chosen to allow comparison with other link layer techniques.


[image: ../../_images/ses.png]

Fig. 37 Criteria for transition to/from the unavailable state




See also

Detailed explanation in ITU-T Y.1563[#1]





L3 Address Refresh

If the Enable Refresh checkbox is checked the tester will periodically emit ARP requests (for IPv4) or Neighbor Advertisement requests (for IPv6).

The period can be set using the Refresh Period field.



Misc. Settings


	Latency Mode: Select the Latency mode to be measured.






Frame Sizes


	ITU-T Default

The default setting is to use the ITU-T standard frame sizes: 64, 128, 256, 512, 1024, 1280 and 1518 bytes.



	Custom Sizes

Lets you specify a comma-separated list of values - useful if you only want to test using one or two packet sizes



	Size Range

Lets you specify a a range of packet sizes and the steps.



	Incrementing Sizes

Lets you specify a Min and Max size - the sizes: Min,Min+1,Min+2,…,Max.



	Butterfly Sizes:

Lets you specify a Min and Max size - the sizes: Min, Max, Min+1, Max-1, Min+2, Max-2,…



	Random Sizes:

Lets you specify a Min and Max size - the sizes will vary between Min and Max randomly.







Footnotes



[#1]
https://www.itu.int/rec/T-REC-Y.1563/en





            

          

      

      

    

  

    
      
          
            
  
Reporting Options Panel


[image: ../../_images/report_options_panel.png]

Fig. 38 Reporting Options Panel



The Reporting tab contains a number of options that affect the way reports are generated for the test.


Identification

This section contains a number of options that can help identify the test context.


	Customer Name

The name of the customer for which the test is performed.



	Customer Service/Access Id

These two options allow you to provide details about the network circuits you are testing.



	Comments

Allows you to provide any multi-line comments for the test configuration.







Report Generation

This section contains options that affect the way reports are generated.


	Report Filename Prefix

Specifies the prefix for the report filename.



	Append Timestamp to Filename

If checked a timestamp on the form <YYYYMMDD-HHMMSS> is appended to the filename prefix.



	Include Graphs in Report

If checked the report will include bar charts showing the test results. This is only applicable for PDF type reports.







Report Formats

This section allows you to select which types of reports will be generated. You can enable several types. The generated report files will be given a file extension that matches the selected type, i.e. “.pdf” for PDF files and so forth.



XML Report Specification

You can find the specification for the XML Report here.



Footnotes



            

          

      

      

    

  

    
      
          
            
  
Troubleshooting

This section contains some guidelines when you encounter a problem with Xena2544, Xena2889, Xena3918, Xena1564, and XenaManager and want to obtain help from your support representative.


Basic Instructions

This section explains how you should report a problem to your support representative.


Describe the Problem

To enable fast resolution of your problem we request that your support request contains the following information:


	Name and version of the Xena test software used (the version can be seen in the main title bar)


	A description of what you are trying to do with the software.


	If the software misbehaved please describe what you actually encountered and you expected instead.


	Screenshots of any error situation.


	The test configuration file for the application (contained in the support archive).


	Any debug log files for the application (contained in the support archive).






Create a Support Information Archive


[image: ../_images/help.png]

The Xena test applications include a menu entry called Create Support Information Archive which will create a compressed ZIP archive containing both the currently loaded configuration file and the content of the Logs and Settings directories. This file can then be emailed to your support representative.

For the Xena2544 and similar test applications this menu entry is located in the Help menu. For the XenaManager application it is located in the Tools ribbon menu.


Note

For the Xena2544 and similar test applications it is important that the configuration file used when the problem was detected is loaded when the support archive is generated. Otherwise the configuration file will not be part of the archive.





Attach Screenshots

Screenshots are a great and easy way of communicating what you see on the screen. To obtain a screenshot of a running program and send it to Xena support perform the following actions:


	Point your mouse inside the program window.


	Press the Alt-PrintSc keys simultaneously.


	Switch to your email program and start a new email message.


	Press Ctrl-V or select Paste from the menu (most likely the Edit menu) to insert the screenshot into the email.







Additional Details

This section goes into a bit more detail about the various items contained in the Xena Support Archive mentioned above.


Configuration Files

The Xena test applications keeps their configurations in special files with an application-specific extension. The extensions used are as follows:


	Xena2544:      .x2544


	Xena2889:      .x1564


	Xena3918:      .x3918


	Xena1564:      .x1564


	XenaManager: .xmcfg




The configuration files will be located in a common Xena data directory on your PC. More specifically they will be located in the following path: C:<UserAppDataDir>Xena<XenaTestApplication>. The <UserAppDataDir> directory depends on your Windows version.

The Xena test applications include a menu entry called Explore Xena Data Directory in the File menu that will open a Windows Explorer in the correct directory, regardless of the Windows version.



Debug Log Files

The Xena test applications logs certain events and errors to a series of debug log file located in the Logs subdirectory under the above mentioned main application data directory. If you encounter errors it may help the support if you include these files in your support request.
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Glossary of Terms


	ARP
	Address Resolution Protocol



	CBS
	Committed Burst Size



	CIR
	Committed Information Rate



	CLI
	Command Line Interface



	DHCP
	Dynamic Host Configuration Protocol



	DIP
	Destination IP address



	DMAC
	Destination MAC address



	DSCP
	Differentiated Services Bode Point



	IPv4
	Internet Protocol v4



	IPv6
	Internet Protocol v6



	LAN
	Local Area Network



	MAC
	Media Access Control



	MPLS
	Multiprotocol Label Switching (MPLS) is a routing technique in telecommunications networks that directs data from one node to the next based on labels rather than network addresses.



	N.A.
	Not Available / Not Applicable



	PCP
	Priority Code Point



	PRBS
	Pseudorandom Binary Sequence is a binary sequence that, while generated with a deterministic algorithm, is difficult to predict and exhibits statistical behavior similar to a truly random sequence.



	SES
	Severe Errored Second



	SMAC
	Source MAC address



	TC
	Traffic Class



	TCP
	Transmission Control Protocol



	TG
	Traffic Generation



	TPID
	Test Payload ID



	TPLD
	Test Payload Data. Each Xena test packet contains a special proprietary data area called the Test Payload Data, which contains various information about the packet. The TPLD is located just before the Ethernet FCS.



	UDP
	User Datagram Protocol



	UI
	User Interface



	UNI
	User-to-Network Interface



	VID
	VLAN ID



	VLAN
	Virtual local area network (VLAN) is any broadcast domain that is partitioned and isolated in a computer network at the data link layer (OSI layer 2).
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